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[Abstract] In this assay, 3’ RACE (Rapid Amplification of cDNA 3’ Ends) followed by PE (primer 

extension), abbreviated as 3’ RACE-PE is used to identify the mRNA 3’ ends. The following protocol 

describes the amplification of the mRNA 3’ ends at the galactose operon in E. coli and the corresponding 

visualization of the PCR products through PE. In PE, the definite primer is 5’ end-labeled using [γ-(32) 

P] ATP and T4 polynucleotide kinase, which anneals to the specific DNA molecules within the PCR 

product of the 3’ RACE. The conventional PE can only be used to locate the 5’ end of an mRNA transcript 

since reverse transcriptase (RTase) polymerizes only in the 5’ → 3’ direction. Thus, Taq polymerase is 

used instead of RTase, PCR is performed. Therefore, we are able to locate the 3’ end of the mRNA 

using this assay. The relative amount of the 3’ end can be directly visualized and quantified by way of 

separating DNA products in a denaturing 8% urea-PAGE (Polyacrylamide Gel Electrophoresis) gel. The 

exact position of the 3’ ends can be sequenced by comparison of these final DNA products with the 

corresponding DNA sequencing ladder. 
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[Background] The synthesis of the mRNA 3’ end is an important step in E. coli that produces a stable 

messenger RNA (mRNA). In eukaryotic cells, the mRNA 3’ end formation is through a cleavage from an 

internal phosphodiester bond, followed by the addition of a poly (A) tail; whereas in prokaryotic cells, the 

3’ ends of mRNAs are generated by termination of transcription or by processing of the primary transcript 

(Altman and Robertson, 1973; Nudler and Gottesman, 2002; Zhao et al., 1999). Therefore, it is important 

to analyze the exact position and relative quantity of mRNA 3’ end to understand the mechanism of 

mRNA generation. 

  3’ RACE assay is a particular procedure to obtain the 3’ end sequence information of a defined RNA 

transcript (Sambrook and Russell, 2006). Generally, the experiment procedure starts with ligating the 3’ 

end of RNA to a synthetic RNA oligo, followed by the synthesis of cDNA using RTase and a 

complementary primer (3RP) to the RNA oligo. Subsequently, specific cDNA is amplified by PCR using 

the gene-specific primer and the primer, 3RP. Usually, RACE products are directly sequenced, however, 

based on our modified procedure, PCR products undergo another concluding step of primer extension 

(PE), which uses Taq polymerase instead of RTase. The labeled primer integrated into the PCR products 
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are extended in a denaturing PAGE gel which makes us visualize and quantify each product. The 

scheme of 3’ RACE-PE is presented in Figure 1. The polycistronic gal operon encodes amphibolic 

enzymes for the amphibolism of the sugar D-galactose (Holden et al., 2003). Using this method, we 

have identified and quantitated the 3’ ends of the gal operon mRNAs in wild type and mutant strains 

(Lee et al., 2008; Wang et al., 2014 and 2015). 

 

 
Figure 1. An illustration of the procedure 3’ RACE-PE in E. coli 

 

Materials and Reagents 
 

1. Pipettes tips (DNase/RNase-free, Sorenson Bioscience) 

2. 1.5 ml centrifuge tube (SARSTEDT, catalog number: 72.690.001) 

3. Cell culture flasks (Corning, catalog number: 3056) 

4. 20 x 150 mm Test tube (Karter Scientific Labware Manufacturing, catalog number: 212W5) 

5. Sephadex G-50 column (GE Healthcare, catalog number: 27-5330-01) 

6. Whatman 3MM paper (GE Healthcare, catalog number: 3017-915) 

7. Kodak CL-XPosure Film (Thermo Fisher Scientific, Thermo ScientificTM, catalog number: 34090) 

8. Gloves (Ultra TEX Glove, Taeshin Bio Science, catalog number: UT-11)  

9. E. coli strains (CGSC, the coli genetic stock center) (an example) 

10. Lysozyme (Roche Diagnostics, catalog number: 10837059001) 

11. TRIZOL (Molecular Research Center, catalog number: TR 118) 
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12. Chloroform (Merck, Sigma-Aldrich, catalog number: C2432) 

13. Isopropanol (Merck, Sigma-Aldrich, catalog number: I9516) 

14. Ethanol (Merck, Sigma-Aldrich, catalog number: E7023) 

15. RNA storage solution (Thermo Fisher Scientific, InvitrogenTM, catalog number: AM7001) 

16. Alkaline phosphatase (Takara Bio, catalog number: 2250A) 

17. DNase I (Thermo Fisher Scientific, InvitrogenTM, catalog number: AM2222) 

18. RNasin® Ribonuclease Inhibitors (Promega, catalog number: N2111) 

19. PCI (Phenol:Chloroform:Isoamyl Alcohol) Solution 25:24:1 (Merck, Sigma-Aldrich, catalog 

number: 77617) 

20. Sodium acetate (Merck, Sigma-Aldrich, catalog number: S2889) 

21. RNase and DNase-free water (Bioneer, catalog number: C-9011) 

22. T4 RNA ligase (Thermo Fisher Scientific, InvitrogenTM, catalog number: AM2141) 

23. The synthesized 3’ RACE RNA oligo: 3’-inverted deoxythymidine (3’-idT) RNA (Dharmacon) 

24. 3RP primer (5’AGCATGCGGCCGCTAAGAAC3’) 

25. dNTP mix (10 mM each) (Thermo Fisher Scientific, Thermo ScientificTM, catalog number: R0191) 

26. HotStarTaq Plus DNA Polymerase (QIAGEN, catalog number: 203603) 

27. Gal-specific primers (Table 1) 

 
Table 1. Sequence of each galactose operon gene specific primers are listed 

Name Primer sequences Usage  
E3 CATCGCCCAGGTTGCTGTAG PCR for detecting mE1 and mE2 ends 
T3 ACGGTAGCCGTACCGTTGTC PCR for detecting mT1 ends 
K3 CGCTGTTGCGCATGAACTGG PCR for detecting mK1 ends 
M3 TCCGCACGACGGCCTGAAAT PCR for detecting mM1 ends 
T6 ATGACGCAATTTAATCCCGT primer extension assay of mE1 ends 
T7 AAATAGCTTCCTGCCTAACGAA primer extension assay of mE2 ends 
T8 ATCCATTTTCGCGAATCCGGA primer extension assay of mT1 ends 
K5 GCCGTACAGCAAGCTGTCG primer extension assay of mK1 ends 
M4 GTTTATTGCTGAGTAATGTTAC primer extension assay of mM1 ends 

 
28. T4 Polynucleotide Kinase (New England Biolabs, catalog number: M0201L) 

29. ATP, [γ-32P]- 6,000 Ci/mmol (PerkinElmer, catalog number: NEG002Z250UC) 

30. 5’ end labeled PE primer (5’ GAGAGTAGGGAACTGCCA 3’) 

31. 5x Developer (Vivid X-RAY DEVELOPER, Duksan (DS) Lab, catalog number: 0514_00004) 

32. 5x Fixer (Vivid X-RAY RAPID FIXER, Duksan (DS) Lab, catalog number: 0514_00003) 

33. Tryptone (BD, DifcoTM, catalog number: 211705) 

34. Yeast extract (BD, DifcoTM, catalog number: 212750) 

35. Sodium chloride (NaCl) (Merck, Sigma-Aldrich, catalog number: 746398) 

36. Galactose (Merck, Sigma-Aldrich, catalog number: G5388) 

37. Acrylamide (Merck, Sigma-Aldrich, catalog number: V900845) 

38. Bis-acrylamide (Merck, Sigma-Aldrich, catalog number: V900301) 

39. 5x TBE (Bioneer, catalog number: C-9002) 
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40. Urea (Merck, Sigma-Aldrich, catalog number: U5128) 

41. Ammonium persulfate (Merck, Sigma-Aldrich, catalog number: 248614) 

42. TEMED (Merck, Sigma-Aldrich, catalog number: T9281) 

43. Formamide (Merck, Sigma-Aldrich, catalog number: F9037) 

44. 0.5 M EDTA, pH 8.0 (Bioneer, catalog number: C-9007) 

45. Xylene cyanol (Sigma-Aldrich, catalog number: X4126) 

46. Bromophenol blue (Sigma-Aldrich, catalog number: B0126) 

47. 1 M Tris-HCl, pH 8.0 (Bioneer, catalog number: C-9006) 

48. Sucrose (Merck, Sigma-Aldrich, catalog number: S7903) 

49. Omniscript RT Kit (QIAGEN, catalog number: 205111) 

50. Sigmacote (Sigma-Aldrich, catalog number: SL2) 

51. LB + 0.5% galactose (see Recipes) 

52. 8% sequencing solution (see Recipes) 

53. 8% Urea-PAGE gel (see Recipes) 

54. 2x gel loading mix (see Recipes) 

55. Protoplasting buffer (see Recipes) 

 

Equipment 
 

1. Automatic pipette aid (Thermo Fisher Scientific, Thermo ScientificTM, model: S1 Pipette Filler) 

2. Pipettes (Gilson Company, USA) 

3. 37 °C shaking incubator (Hanbaek Scientific Co., Korea (S)) 

4. 37 °C and 42 °C heat block (FINEPCR, Korea (S)) 

5. Spectrophotometer (BECKMAN COULTER, USA) 

6. Vortex-Genie 2 (Scientific Industries, model: Vortex-Genie 2) 

7. 4 °C micro-centrifuge (Beckman Coulter, USA) 

8. NanoDrop 1000 (Thermo Fisher Scientific, Thermo ScientificTM, model: NanoDropTM 1000) 

9. PCR machine (Bio-Rad Laboratories, USA) 

10. Shallow fixer tray (Bio-Rad Laboratories, USA) 

11. Sequencing gel electrophoresis apparatus (LABREPCO, USA) 

12. X-ray cassette (Duksan (DS) Lab, Korea (S)) 

13. Power supply (Bio-Rad Laboratories, USA) 

14. Autoclave (Dong Won Scientific Corp, Korea (S)) 

 

Software 
 

1. ImageJ 
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Procedure 
 
A. RNA extraction 

1. Streak out the E. coli strain to be used for RNA extraction on an LB plate and incubate overnight 

at 37 °C. 

2. Select a single colony from the streaked LB agar plate. Inoculate E. coli strain in 3 ml fresh LB 

medium supplemented with 0.5% galactose, and then grow for 16 h. The next day, assess the 

bacterial growth by measuring the OD600, usually it is around 4. 

3. Dilute the culture in 50 ml pre-warmed (37 °C) LB medium supplemented with 0.5% galactose 

to give an OD600 reading of about 0.05.  

4. Grow the bacterial culture at 37 °C in a shaking incubator. Assess the OD600 till it reaches 0.6, 

usually it takes 1 h 50 min for the wild type E. coli cell. At this time, the number of cells in 1 ml 

culture is about 2 x 108. 

5. Collect 1 ml cells in a microcentrifuge tube, pellet the cells by centrifugation (12,000 x g, 1 min, 

20 °C). 

6. Discard the supernatant by pipetting, resuspend the cell pellet in 50 µl protoplasting buffer, and 

add 5 µl lysozyme (50 mg/ml), mix thoroughly, incubate for 5 min at room temperature. 

7. Add 500 µl Trizol, mix thoroughly by vortexing for 15 sec. incubate e the lysed sample for 5 min 

at room temperature. 

8. Add 100 µl chloroform to the lysate, shake vigorously for 15 sec. incubate the resulting mixture 

at room temperature for 5 min, and centrifuge at 12,000 x g for 15 min at 4 °C. 

9. Following the centrifugation process, the mixture separates into 3 layers: a clear upper aqueous 

layer (containing RNA), an interphase and a red lower organic layer, carefully transfer 250 µl of 

the upper aqueous phase to a fresh tube. 

10. Precipitate RNA from the aqueous phase by mixing 250 µl (equal volume) of isopropanol. 

11. Store samples at room temperature for 10 min and centrifuge at 12,000 x g for 15 min at 4 °C. 

12. Decant the supernatant and wash the RNA pellet by vortexing in 1 ml 75% ethanol. 

13. Centrifuge the RNA suspension at 12,000 x g for 5 min at 4 °C. 

14. Remove the remaining ethanol by repeating the centrifugation process and briefly air-dry the 

RNA pellet for 5 min (air-dry can be carried on at room temperature). 

15. Dissolve RNA in 30 µl RNA storage solution. 

16. Measure the concentration of RNA by NanoDrop. Typically, 800-1,000 ng/µl RNA can be isolated 

from 1 ml of E. coli culture. 

 

B. DNase I and Alkaline Phosphatase treatment 

1. Resuspend 25 µg RNA in 1x AP Reaction Buffer to a final volume of 50 µl. 

2. Add 3 U of DNase I, and 45 U of Alkaline Phosphatase, 20 U of RNasin® Ribonuclease Inhibitors, 

mix thoroughly and incubate at 37 °C for 30 min. 

3. Add 50 µl PCI, mix thoroughly by vortexing for 10 sec. 
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4. Centrifuge at 12,000 x g for 5 min. 

5. Collect 30 µl of supernatant, and transfer to a Sephadex G-50 column. 

6. Centrifuge at 2,000 x g for 2 min, collect the pass through. 

7. Measure the RNA concentration by NanoDrop. Typically, 300-400 ng/µl RNA can be collected. 

 

C. Ligation 

1. Deprotection of 3’-idT RNA oligo 

a. Centrifuge the tube briefly. Add 400 µl of deprotection buffer to the tube, vortex for 10 sec 

and centrifuge for 10 sec. 

b. Incubate at 60 °C for 30 min. 

c. Perform phenol extraction and ethanol precipitation as follows: add 400 µl of PCI solution 

to the tube, vortex for 5 sec. 

d. Centrifuge at 12,000 x g for 5 min at room temperature. 

e. Carefully remove the 300 µl upper aqueous phase to a new tube. 

f. Add 2.5 volume of ice cold 100% ethanol, 0.1 volume of 3 M sodium acetate, and vortex to 

mix thoroughly. 

g. Precipitate at -80 °C for 20 min. 

h. Centrifuge at 12,000 x g for 20 min at 4 °C. 

i. Decant the supernatant and carefully pipet off the remaining supernatant, wash pellet twice 

by adding 500 µl ice cold 70% ethanol. 

j. Air dry the pellet at room temperature and resuspend in 100 µl of RNase and DNase-free 

water. 

2. Set up a 20 μl reaction as follows:  

2 µl 10x RNA ligase buffer  

0.25 µl RNasin (40 U/µl) 

1 μl T4 RNA ligase (5 U/µl) 

2.5 µg RNA 

0.5 µl 3’ RACE RNA oligo (100 nM) 

RNase-free water  

3. Incubate at 37 °C for 3 h. 

The sequence of 3’ RACE RNA oligo is 5’ P. UUCACUGUUCUUAGCGGCCGCAUGCUC.idT 

4. Apply the ligation mix to a G-50 column for buffer exchange, centrifuge at 2,000 x g for 2 min 

and collect the pass through in a new micro centrifuge tube. 

 

D. Reverse transcription 

1. Assemble 3RP primer, dissolve the primer in RNase- and DNase-free water to make a 100 µM 

stock solution (= concentration). A working solution of 25 µM was made by diluting in RNase 

and DNase-free water from this stock. 

Sequence of 3RP primer (5’AGCATGCGGCCGCTAAGAAC3’) 
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2. Set up a 20 μl reaction as follows: 

2 µl 10x RTase buffer  

0.25 µl RNasin (40 U/µl) 

1 μl RTase (4 U/µl)  

Ligation product 13.75 µl 

1 µl 3RP primer (25 µM) 

2 µl dNTP mix (5 mM) 

3. Incubate at 37 °C for 2 h. 

 

E. PCR 

1. Assemble primers, as in Table 1. 

2. Set up a 50 μl reaction as follows: 

5 µl 10x PCR buffer  

0.5 µl HotStarTaq plus DNA polymerase (5 U/µl) 

1 µl dNTP mix (10 mM) 

1 µl 3RP primer (25 µM) 

2.5 µl gal-specific primer (10 µM) 

2 µl cDNA 

38 µl RNase-free water  

3. Transfer PCR tubes to a PCR machine with the lid pre-heated to 105 °C and run the 

thermocycling process. Thermocycling conditions for PCR are shown in Table 2. 

 

Table 2. Thermocycling conditions for PCR 

Initial denaturation  95 °C  5 min 

30 cycles  94 °C 
60 °C 
72 °C  

30 sec 
30 sec 
1 min  

Final extension  72 °C  5 min  

Hold  4 °C   
 

F. Primer end labeling 

1. Set-up the following reaction to a final volume of 20 µl: 

2 µl 10x kinase buffer 

1 µl kinase (10 U/µl) 

2 µl primer (10 µM) 

2 µl [γ-32P] ATP 

13 µl RNase-free water  
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2. Incubate at 37 °C for 30 min. 

3. Inactivate the enzyme at 65 °C for 30 min. 

4. Add 30 µl RNase and DNase-free water to the reaction mix, pass through the G-50 column by 

centrifuge at 2,000 x g for 2 min. 

5. Store the labeled primer at 4 °C. 

 

G. Primer extension 

1. Set-up the following reaction to a final volume of 20 µl: 

2 µl 10x PCR buffer  

0.2 µl HotStarTaq plus DNA polymerase (5 U/µl) 

0.3 µl dNTP mix (10 mM) 

0.3 µl 5’ end labeled PE primer   

2 µl DNA template 

15.2 µl RNase-free water 

2. Transfer PCR tubes to a PCR machine with the lid preheated to 105 °C and run the 

thermocycling process. Thermocycling conditions for PCR are shown in Table 3.  

 

Table 3. Thermocycling conditions for PE 

Initial denaturation  95 °C  5 min 

25 cycles  94 °C 
52 °C 
72 °C  

30 sec 
1 min 30 sec 
30 sec 

Final extension  72 °C  5 min  

Hold  4 °C   
 

H. Gel electrophoresis 

1. Gel casting 

a. Assemble the gel according to manufacturer’s description and fix the gel in the gel-casting 

chamber. Use 0.4 mm thick spacers, glass plates (Inner plate x outer plate (W x H): 31 x 38.5 

cm), 4 x 0.4 mm (14 cm) gel comb). 

b. Prepare 50 ml of the 8% urea-PAGE solution.  

c. Pour the gel immediately using an automatic pipette aid between the two glass plates. Avoid 

introducing air bubbles. Insert the comb and let the gel polymerize for 60 min. The assembled 

gel is indicated as in Figure 2.  
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Figure 2. A picture of assembled gel in the gel-casting chamber with the automatic pipette 
aid 

 

2. Set up the electrophoresis apparatus and pre-run the gel  

a. Dismount the gel from the casting chamber and assemble it to the gel apparatus according 

to the manufacturer’s instructions. 

b. Fill the lower buffer chamber with 1x TBE running buffer, so that the glass plates will be 

submerged 2-3 cm with the buffer. Fill the upper buffer chamber up to the top of the gel with 

1x TBE running buffer. 

c. Carefully remove the comb and rinse the wells with running buffer by using a pipette and 

gel loading tips. 

d. Attach the lid of the gel system and plug in the cables to a high voltage power supply. Before 

loading the samples you have to prerun the gel for at least 30 min to heat up the gel and to 

remove the remaining urea from the gel. The optimal temperature should be between 45-

55 °C. Avoid temperatures higher than 60 °C as bands could smear or the glass plates could 

crack. Choose a constant watt for the prerun (30 W). The assembled electrophoresis 

apparatus is indicated as in Figure 3. 
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Figure 3. A picture of the assembled electrophoresis apparatus 
 

3. Sample preparation 

a. Add 15 µl 2x gel loading mix to 15 µl sample.  

b. Denature the sample by heating at 95 °C for 3 min. 

4. Load and run the gel 

a. Remove the lid and rinse the wells thoroughly as described earlier as urea will leach into 

the wells. 

b. Load 3 µl of samples carefully from the bottom of the wells. Avoid introducing air bubbles.  

c. Assemble the lid and run the gel at 30 W to maintain a gel temperature of 55 °C similar to 

the prerun. Observe the migration of the marker dyes until the dye front reached the lower 

end of the gel. A run can last 2-4 h. 

5. Process the gel 

a. Remove the gel cassette from the chamber by loosening the clamps. Pull away the spacers 

and carefully disassemble the glass plates. If necessary, cut away the upper well containing 

the gel part. 

b. Cut a Whatman 3MM paper to the same size of the gel, attach it to the gel, and carefully 

remove the gel from the glass plate.  

c. Carefully attach a saran wrap on top of the gel, seal it with scotch tape. A picture of the 

Whatman 3MM paper cut and saran wrapped is indicated as in Figure 4. 

d. Move the sealed gel to the X-ray cassette, put in a single piece of X-ray film, expose at -

80 °C for 16 h. 
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Figure 4. A picture showing the Whatman 3MM paper cut the same size as the outer plate 
or gel, saran wrapped sealed with scotch tape placed in the X-ray cassette  
 
e. After the exposure time, take out the cassette from the refrigerator, wait about 1 h until it 

warms up to the room temperature. 

f. Develop the X-ray film in a dark room. Firstly, dilute one-part concentrate of the developer 

to 4 parts of water. Mix and store it in a bottle. Prepare the fixer in the same way. Then, pour 

the developer into a container, take the exposed X-ray film out of the cassette, immerse the 

film into the developer. After several minutes, when the dark bands appear, rinse the film 

with distilled water and then fix the film in the fixer. 

 

Data analysis 
 
The data can be scanned and quantified using the software ‘ImageJ’ (https://imagej.nih.gov/ij/). ImageJ 

is a Java based software by Wayne Rasband and others from National Institute of Health (USA). 

A. Scanning the film and setting the measurement criteria 

1. Create high resolution scans from the film in .tiff file format. Keep this as your source image, 

and use it for the quantification analysis.  

2. Start the ImageJ analysis software and load the previously saved .tiff file from the destination 

folder using the ‘File’ menu. Change the picture format to .jpeg and the picture mode to 

‘grayscale’. 

3. Under the ‘Analyze’ menu, choose ‘Set Measurements’. From the checkboxes have the ‘Area’ 

checked (Figure 5). 
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Figure 5. ImageJ software interface showing the Menu and tool features. The bottom 

picture explaining the different types of ‘Set Measurements’ options, checked ‘Area’ for our 

specific quantification of the 3’ end bands.  

 

B. Selection for measurements 

1. ImageJ selection of measurements defines a rectangle area of interest across the lanes of the 

final PE products of the 3’ RACE. Choose the ‘rectangle’ tool from ImageJ and draw a frame 

around the bands of the samples.  

Notes:  

a. You can trail around and resize the frame. 

b. Adjust it so that it covers the area to contain the whole of the largest and the smallest band 

of the sample row. 

2. For each of the analysis to take measurements, for instance in Figure 6, the first lane will be the 

control and all the other bands across the lanes will be the samples to quantify and compare. 

Centre the band inside the frame and utilize the ‘Ctrl’ + ‘M’ to record a measurement or choose 

‘Measure’ from the ‘Analyze’ menu. 

3. This will spread out the measurement window and display the area peaks of the samples in 

order. Make a closed peak of the samples by using the ‘Straight’ tool to draw freehand lines to 
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find the area of the individual sample peaks. Applying the ‘Wand’ tool obtains the area of the 

individual sample peaks as shown in Figure 6. 

 

 
Figure 6. An example of quantifying 3’ RACE-PE results using ImageJ. A. A schematic of 

the galactose operon. The transcription initiation site from the P1 promoter is marked as + 1. 

The positions of primers used to amplify the 3’ ends of mT1 are indicated by small arrows. The 

gel image showing the 3’ ends of galT mRNA in WT and Δspf strains by 3’ RACE-PE. The 

numbers on the sides of each gel picture indicate relative positions to the P1 transcription start 
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site (+1) (Lee et al., 2008). B. The peaks and area table of the mT1 bands. Bands framed by 

the ‘Rectangle’ tool in yellow is used to obtain the peaks and to find the area of these 3’ end 

bands. 

 

C. Spreadsheets and calculations 

1. When the area of the peaks of the bands along with the loading control band is obtained, the 

data are transferred to an Excel sheet. 

2. When the area of sample bands with respect to the control band is recorded, a ratio of samples 

band value over the control band of that lane is calculated (Figure 6. Lane 2, 3, 4 over Lane 1 

(Control)). 

3. The final relative quantitative values are the proportion of the sample bands to the control band. 

4. A bar (or other) graph is constructed to compare the samples with respect to the control. 

 

Notes 
 

1. The amount of starting sample should not exceed the capacity of Trizol-reagent. Overloading 

will reduce the quality of RNA. 

2. Use RNase-free reagents and filter tips during the whole process of the experiment. Wear 

gloves and keep the tubes closed throughout the procedure. 

3. PCR cycles can be modified depending on the amount of product.  

4. The time of exposure on the X-ray films from the gel at -80 °C can be modified according to the 

intensity of band. 

5. A specific area of the laboratory should be designated for P-32 handling. When handling 

radioactive materials, always wear protective gloves and clothing, use a Plexiglas shield to 

prevent radiation. Try to keep your exposure time as short as possible. The radioactive materials 

should be kept in lead-lined containers, and experiment wastes should be discarded in 

designated containers. Use the Geiger counter to check the radiation level in front of the shield 

and your gloves frequently for contamination. 

 

Recipes 
 

1. LB + 0.5% galactose (1 L) 

10 g tryptone 

5 g yeast extract 

10 g NaCl 

Add distilled water up to 1 L 

Autoclave 

Add 25 ml filtered 20% galactose 

Store at room temperature 
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2. 8% sequencing solution (1 L) 

76 g acrylamide 

4 g Bis-acrylamide 

200 ml 5x TBE 

500 g urea 

Add distilled water up to 1 L 

Dissolve by heating and stirring 

3. 8% Urea-PAGE gel (50 ml) 

49.67 ml 8% sequencing solution 

300 µl 10% APS solution 

30 µl TEMED 

4. 2x gel loading mix 

9 ml formamide 

200 µl 0.5 M EDTA 

100 µl 1% xylene cyanol  

100 µl 1% bromophenol blue 

Add RNase and DNase-free water up to 10 ml 

5. Protoplasting buffer 

750 µl 1 M Tris-HCl (pH8.0) 

7.7 g sucrose 

800 µl 0.5 M EDTA (pH8.0) 

Add RNase and DNase-free water up to 50 ml 
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